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List of terms used in SALTO Integration
Module Configuration and Operation Manual

Access is a moving of users, transport and other objects into (out of) the premises, buildings, zones and territories.
Server is a computer with installed Server configuration of Intellect software package.

Client is a computer with installed Client configuration of Intellect software package.

Controller is an electronic device for control over access points.

Access control system (ACS) is a hardware-software complex for carrying out access control functions.

Readers are electronic devices for keyboard inputting the stored code or for reading code information from system keys
(identifiers).

Access point is a place where there is access control. Access point can be performed by the door, turnstile, gates, barrier
that are equipped by reader, electromechanical lock and other means of access control.

Access identifier is a key (physical or digital) using which one can access the premises, buildings, zones and territories.
Access card is a physical access identifier that is registered by reader.
Encoder is an electronic device for specifying access cards to users.

Time schedule - a set of any number of time intervals during a day (24 hours) defined for several days (1 to 366), and the
time intervals during specific dates. Time schedule defines a schedule of access to the secured object.

PPD (portable programming device) - device used for transferring data between Salto devices and computer.

SHIP (Salto Host Interface Protocol) is a protocol by which the SALTO ACS vendor software operates with the software of
third-party manufacturer.

Time schedule - a set of any number of time intervals during a day (24 hours) defined for several days (1 to 366), and the
time intervals during specific dates. Time schedule defines a schedule of access to the secured object.

Introduction into SALTO Integration Module
Configuration and Operation Manual

On the page:

® Purpose of document
® General information about SALTO
integration module

Purpose of document

Configuration and operation manual for the SALTO integration module is an informational reference manual intended for
use by configuration specialists and operators of the SALTO module. This module is a part of the fire and security alarm
subsystem (SALTO) implemented with the ACFA Intellect software package.

This Guide contains the following materials:

1. general information on the SALTO integration module;
2. configuration of the SALTO integration module;
3. operation of the SALTO integration module.

General information about SALTO integration module

SALTO integration module is a component of ACS that is carried out on the basis of ACFA Intellect software package. It is
for realization of the following functions:

1. SALTO ACS configuration (SALTO Systems is a vendor);
2. providing interaction between SALTO ACS and ACFA Intellect (monitoring, control).

Note.
For more information on the SALTO ACS system, refer to the official documentation on this system.

1 Attention!



The server of ACFA Intellect started on one computer and the software of the SALTO ACS vendor are essential for
operation of the SALTO integration module.

.[:D Note.

Remote control over the SALTO module can be performed from the Clients of distributed system that is
constructed on the basis of ACFA Intellect software package.

Before operation of the SALTO integration module do the following:

1. Install the SALTO ACS hardware at the guarded object (see the reference documentation on the SALTO ACS).
2. Configure the SALTO ACS in vendor’s software (see the official reference documentation).
3. Connect the SALTO ACS to the Server.

Configuration of SALTO integration module
Procedure for configuring of SALTO integration module

The SALTO integration module is configured through the following steps:

Configuration of SALTO ACS in vendor software.

Configuration of SALTO ACS connection to ACFA Intellect software package;
Downloading and recording of SALTO ACS configuration;

Assigning the access levels to users;

Specifying the SALTO ACS cards;

Configuration of the SALTO ACS doors;

Configuration of the SALTO ACS zones.

Configuration of SALTO ACS in vendor software
Procedure of configuring of SALTO ACS in vendor software

This chapter contains first steps for getting started the SALTO ACS. More detailed configuration has to be accomplished in
accordance with vendor manual.
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After the SALTO ACS vendor software installation do the following steps:

Create a database.

Configure the SHIP port for data transfer.
Add the peripherals to the list.

. Configure the wireless locks if it is necessary.

Creatlng a SALTO ACS database

To create the SALTO database at the first startup of SALTO vendor software, do the following:

1. Start the SALTO vendor software.
2. In the File menu, select New DB->New DB.
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3. From the Server drop-down list select database server name (1).
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In the Database field, enter a new database name (2).
In the Serial No field, enter a product serial number or leave the field empty (3).
Set the Windows authentication checkbox if it’s necessary to use Windows credentials (4).
If it's necessary to use SQL-server authentication do the following steps:
a. Set the SQL server authentication checkbox (5).
b. Enter the user login name and password (6).
8. To save changes click Ok (7).
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The new database creation is completed.

Configuration of a SHIP port

To configure the SHIP port, do the following steps:

1. In the Tools menu, select Configuration -> General options.
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2. In the opened Options window select the SHIP tab (1).
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3. Set the Enabled checkbox (2).
4. In the TCP/IP port field, enter the port number for data transfer via SHIP (3).

5. To save changes click Save (4).
SHIP port configuration is completed.

Adding peripherals

To add peripherals like controllers or gates, do the following steps:

1. In the Peripherals menu, select Peripheral list.
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2. To add the device click New.
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In the Name field, enter a name of added device (1).
In the Description field, enter information about this device (2).
In the IP address field, enter an IP address of device (3).
From the Peripheral type drop-down list, select a type of the connected device (4).
To save changes click Save (5).

Peripheral will be added to the Peripheral list (1).




Hperipheral lisk i _ Ol =|
f Sort Search [Description]
< 4 =k I D escription ﬂ I ﬂ
Dezcription IP addrezs Feripheral type
Caontrol unit 192168 . | Ethernet online control unit
1
3
Sigrial H Address | ) Address [FPD) | Show firmware |
[G View details | E Delete | &5 Frint | [+ Close |

10. To set the connection to the online controller do the following:
a. Click Scan on (2).
b. Press tamper on the peripheral card (1).

c. Wait when the indicator near the tamper starts flashing (2).

(D Note.

Open the device case for access to temper.

&
d. Click Address (3). If the connection established, indicator will be displayed in the com. column.
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Adding a peripheral is completed.
Configuration of wireless locks

Procedure of configuring wireless locks

Configuration of the wireless locks in the SALTO ACS vendor software is

1. Wireless locks activation in the system.
2. Wireless locks creation.
3. Wireless locks initialization.

Wireless locks activation in the system

To use the wireless locks, set the SALTO ACS vendor software as follows:

1. In the Tools menu, select Configuration -> General options.
2. Select the Advanced tab (1).

done in the following order:
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3. In the Available parameters list select the RF_ENABLED object and double click it (2).
4. Parameter will be added to the Advanced parameters list (3).
5. Click Close to hide the Options window (4).

As a result of wireless locks activation the RF-lock door type can be specified in the door settings (see chapter Wireless
lock creation).

The RF-locks switching is completed.
Wireless lock creation

For wireless locks creation, do the following steps:

1. Click the Doors button.
RW Pro-Access For Service [WS3\SOLEXPRESS\SALTO_RW]
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3. In the Name field enter the wireless lock name (1).
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4. Set the Is RF checkbox (2).
5. Click Save to save changes (3).

Wireless lock will be added to the door list.

Wireless lock creation is completed.

Wireless locks initialization

Wireless locks are initialized through the following steps:

1. Connect PPD to USB-port.



2. Click Connect PPD.The PPD connection window opens.
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3. Set the Initialize locks checkbox in the PPD connection window (1).
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(D Note.

If the Initialize locks checkbox is not set, then the INITIALIZE LOCKS object is not available in the
PPD menu.

4. Select the connected wireless locks (2).

(D Note.

It is not essential to initialize all doors simultaneously but it’s not recommended to postpone the door
initialization.

5. Click Download (3). Wait while the data transfer to PPD will be completed.
6. Disconnect the PPD from the USB-port.
7. Turn on PPD and go to the device main menu.
8. In the PPD menu select INITIALIZE LOCKS.
9. In the PPD menu select the name of the initialized lock.
10. Connect the PPD to wireless lock.
11. Wait for the sound signal. It means that the lock receives information from PPD and gives its identifier to PPD.
12. Disconnect the PPD from the wireless lock.
13. Repeat steps 8-12 for all locks to be initialized.
14. Connect the PPD to the USB-port.
15. Click Connect PPD. Information about locks is sent to the software. Locks are connected to the gate.

Wireless locks initialization is completed.

Configuration of SALTO ACS in ACFA Intellect software
package



Configuration of SALTO ACS connection to ACFA Intellect
software package

Configuration of the SALTO ACS connection to ACFA Intellect software package is performed on the setting panel of the SA
LTO Server object. This object is created on the basis of the Computer object on the Hardware tab of the System
settings dialog box.
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To configure the connection of SALTO ACS to ACFA Intellect software package do the following:
1. Go to the setting panel of the SALTO Server object.
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Save configuration

| Karneworep w54

SALTO Encoder 1 -

2. In the Server IP-address field set the IP address of computer on which SALTO ACS software is installed (1).

3. In the Server port field set the TCP/IP port address of SALTO integration module connection to SALTO ACS softwar
e which is designed for transferring data by SHIP-protocol while configuring the vendor software (2).

In the Listening port field set the port to which the queries of SALTO ACS software will be forwarded (3).

Set Trace changes in ACS checkbox for automatic forwarding of user changes, time schedules and access levels
to SALTO ACS software (4).

From the Default encoder drop-down list select the encoder which will be used on default (5)

To save changes click Apply (6).

vk
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(D Note.

To cancel changes click Cancel (7).

Configuration of SALTO ACS connection to ACFA Intellect software package is completed.

Downloading and saving of SALTO ACS configuration

Downloading of SALTO ACS configuration is performed on the setting panel of the SALTO Server object.

— =
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L—J
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Usger advanced settings
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To download SALTO ACS configuration click Read device configuration (1).

As a result new objects appear in the object tree of ACFA Intellect software package.
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To record configuration in SALTO ACS software click Save configuration (2).

Note.
Depending on configuration of SALTO ACS vendor software users access cards updating can be necessary after
configuration record (see chapter Assigning access cards of SALTO ACS).

Extended configuration of SALTO ACS user access level in ACFA
Intellect

SALTO ACS software package allows specifying access levels separately for all registered users in the controller system or
zone through the following steps:

1. Go to the setting panel of the SALTO Server object.
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2. Click User advanced settings.
3. The Advanced user settings window opens.

SALTO DoorfReader 1 | SALTO Zone 1

Full access Arccess denied

. Select the required access level through the peripheral in the appropriate drop-down list for all registered users (1).
. To save changes click Apply (2).

u b

Note.
(D Click Cancel to close Advanced user settings window without saving changes (3).

Access levels are assigned to users.

Assigning access cards of SALTO ACS

Assigning access cards of SALTO ACS is performed on the setting panel of the SALTO Encoder object. This object is
created on the basis of the SALTO Server object while downloading SALTO ACS configuration (see chapter Downloading
and saving of SALTO ACS configuration of this documentation).

15
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[T [SALTO Encoder 1

SALTO Server W il
|SALTO Server 1

Full Kame
User 1

r Refrezh card

Cancel card

1 Attention!
* Assigning access cards of SALTO ACS is impossible in case when the Encoder object is created manually in ACFA
Intellect software package.

To assign access cards of SALTO ACS do the following:

1. In the Card-waiting period, s field set time (in seconds) that specifies the time interval after clicking Assign card
or Refresh card and that is for bringing access card to encoder (2).

(D Note.

In the Name field the name of encoder object in SALTO ACS software is specified (1).

(D Note.

In the 3 field the users created in ACFA Intellect software package are displayed (3).

2. To assign the access card to the user select necessary user in the 3 field click Assign card and bring the access
card to the encoder during the period specified in the Card-waiting period field (4).
Attention! For correct access cards’ assigning it’s necessary to register users without using Russian
symbols.

3. To assign the new access card to the user select necessary user in the 3 field click Refresh card and bring the
access card to the encoder during the period specified in the Card-waiting period field (5).

4. To cancel the access card to the user select necessary user in the 3 field click Cancel card (6)

5. To save changes click Apply (7).

(D Note.

To cancel changes click Cancel (8).

Assigning access cards of SALTO ACS is completed.

Configuration of SALTO ACS doors

Configuration of SALTO ACS doors is performed on the setting panel of the Door/Reader object. This object is created on
the basis of the SALTO Server object while downloading SALTO ACS configuration (see chapter Downloading and saving of
SALTO ACS configuration of this documentation).
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To configure SALTO ACS doors do the following:

1. In the Name field set the name of the door (1).
2.
3. In the Door open time field set time (in seconds) that specifies the time interval from the moment of door opening

In the Description field set the description of the door (2).

by the user till the moment of its automatic closing (3).

. Set the Record events to card checkbox if it's necessary to record Access forbidden and Access permitted eve

nts to the access card of the user who showed (4).

. From the Enter drop-down list select the Partition object name corresponding to the area which is located in the

site of exit through this door (5).

. From the Exit drop-down list select the Partition object name corresponding to the area which is located in the

site of enter through this door (6).

. From the Antipassback drop-down list select the value to enable or disable the antipassback (6).
. To save changes click Apply (6).

Note.
To cancel changes click Cancel (7).

Configuration of SALTO ACS doors is completed.

Configuration of SALTO ACS zones

Configuration of SALTO ACS zones is performed on the setting panel of the SALTO Zone object. This object is created on
the basis of the SALTO Server object while downloading SALTO ACS configuration (see chapter Downloading and saving of
SALTO ACS configuration).
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To configure SALTO ACS zones do the following:
1. Go to the setting panel of the SALTO Zone.

11 [58LTO Zone 1

SALTO Server B Uiz ble
([54LT0 Server 1
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In the Salto name field enter the zone name which will be specified to the object in SHIP (1).
In the Description field set the description of the zone (2).

Select doors which are included in configurable zone (3).

To save changes click Apply (6).

nhwn

Configuration of SALTO ACS zone is completed.

Operation of the SALTO integration module

General information about SALTO module operation

The following interface objects are used in order to operate the SALTO integration module:

1. Card;
2. Event log;
3. Visitor Management System.

Information about these interface objects setting is given in the Intellect™ Software Package Administrator's Guide and in
the Visitor Management System Module Settings and Operation Guide.
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Operation of interface objects is given in details in the Intellect™ Software Package Operator's Guide.

SALTO door control

Door control of the SALTO integration module is performed in the interactive Map window through the functional menu of
the SALTO Door object.

SALTO Door/Reader 1[1.1]

Ernergency apen
End emergency
Emergency close
Cpen door

Functional menu description of the SALTO Door object:

Functional menu Performed function

command
Emergency open Emergency door opening. After emergency door opening the door is not closed automatically.
End emergency Emergency door mode changes to normal.

Emergency close Emergency door closing. After emergency door closing the door is blocked and closed and can’t be
opened.

Open door Door opening. After it door will be automatically closed in time specified in the Door opening time
field (see chapter Configuration of SALTO ACS doors).
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